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1 Technology Overview

1.1 Introduction to Technology

The AV Processing Center DSP series incorporates multiple core technologies to help you
complete audio engineering tasks more efficiently. The DSP-based audio hardware can be routed
and controlled via a computer, and this manual focuses on the technologies required to achieve
that functionality.

DSP Controller is a Windows-based application used to configure and control DSP hardware. It
includes 16 built-in presets, each of which allows flexible adjustment of processing modules and
their order according to your design needs. Once configured, presets can be saved for long-term
use. The default module sequences and parameters are suitable for most applications, allowing
you to use them directly without additional modifications.

As a full-featured application, DSP Controller supports processing module editing, parameter
adjustments, and peripheral configuration such as RS-232, RS-485, and compatible panel setup.
Its most notable feature is the customizable user interface, which enables you to create a
tailored interface, have it edited by integrators, and allow on-site technicians or non-technical
end users to operate it. Advanced security features ensure that end users can only access
controls authorized by you or the system designer.

1.2 Audio Input Section

The DSP supports up to 16 fixed analog audio inputs, connected via detachable balanced Phoenix
connectors. Each analog input can accept MIC or LINE level signals, with adjustable preamp gain
per channel ranging from 0, 3, 6, 9, 12, 15, 18, 21, 24, 27, 30, 33, 36, 39, 42, 45, to 48 dB. Each
input can also use +48 V DC phantom power.

Preamp gain and phantom power can be controlled via DSP Controller.

A/D Specifications
Sampling Rate / Bit Depth: 48 kHz / 24 Bit
Total Harmonic Distortion + Noise (THD+N): 0.001% @ 4 dBu (A-weighted)
Dynamic Range: 113 dB (A-weighted)
Audio Format: 24 Bit MSB TDM
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1.3 Audio Output Section

The first stage of the analog output is the D/A converter (DAC). The DSP uses a high-performance
24-bit 256x oversampling converter. Like the A/D converter, its multi-bit architecture provides a
wider dynamic range while maintaining distortion performance comparable to conventional
high-quality digital-to-analog converters.
D/A Specifications
Sampling Rate / Bit Depth: 48 kHz / 24 Bit
Total Harmonic Distortion + Noise (THD+N): ≤0.001% @ 4 dBu (A-weighted)
Dynamic Range: 113 dB (A-weighted)
Audio Format: 24 Bit MSB TDM

1.4 Float Point DSP

The DSP device uses an ADI SHARC processor with 32-bit to 40-bit floating-point processing
capabilities. Floating-point processing offers significant advantages in audio quality and usability.
Limitations of Fixed-Point Processing
Fixed-point processing has inherent constraints: when gain changes significantly, data loss or
clipping distortion may occur. For example, a 24-bit fixed-point processor handling a 24-bit audio
signal will see a dramatic reduction in overall dynamic range if the signal is attenuated by 42 dB.
The processor’s precision exceeds the effective dynamic range of the new signal, with extra bits
reserved for subsequent high-dynamic signals, leading to degraded audio quality after
attenuation. A 42 dB attenuation corresponds to a permanent loss of 7 bits. Clipping is another
concern: if a near 0 dBFS signal undergoes substantial gain, it may clip at 0 dBFS, causing
distortion that persists even if the level is later reduced. Fixed-point systems may attempt to
reserve headroom above 0 dBFS, but this requires sacrificing bits and cannot achieve true
floating behavior within cost constraints.
Advantages of Floating-Point Processing
Floating-point processing differs in that all available bits are consistently allocated regardless of
signal level. Part of the bits store the exponent to represent approximate signal level, while the
remaining bits store the actual signal value independently of level. Therefore, signals from -200
dB to 0 dBFS and above during calculation, can maintain high precision without clipping. SHARC’s
32-bit floating-point processing allocates roughly 25 bits to store the signal, maintaining
low-level accuracy superior to 24-bit fixed-point, while 40-bit floating-point allocates about 33
bits for signal storage.
Practical Implications
Floating-point processing allows flexible gain adjustments between modules: even if one module
attenuates a signal by 50 dB and a subsequent module restores it, no data loss occurs. In
fixed-point systems, you must carefully control signal levels before the D/A converter to avoid
clipping. In floating-point DSP systems, if output clipping occurs before the D/A converter, you
can adjust it at the output directly, without tracing the signal through each processing module.

1.5 Audio Flow
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2 Hardware

2.1 Safety

Important Safety Instructions
1. Please read these instructions carefully.
2. Keep this manual for future reference.
3. Observe all warning information.
4. Follow all operating instructions.
5. Do not use the device near water to prevent contact with dripping or splashing liquids, and
ensure no containers of water are placed nearby.
6. Clean the device only with a dry cloth.
7. Do not block ventilation openings; install the device strictly according to the manufacturer’s
instructions.
8. Do not place any heat sources near the device, such as radiators, heaters, stoves, or other
heat-generating equipment, including power amplifiers.
9. Connect the device to a power outlet with protective grounding. Do not alter polarized or
grounded plugs. A polarized plug has one blade wider than the other, and a grounded plug has
two blades and a grounding pin, all designed for your safety. If the plug does not fit the outlet,
contact a qualified electrician to replace it.
10. Protect the power cord from being walked on or pinched, especially at plugs, outlets, and
points of connection to the device.
11. Use only accessories or attachments specified by the manufacturer.
12. Use only manufacturer-provided or recommended carts, tripods, stands, or tables. When
using a cart, move the device combination carefully to prevent tipping and injury.
13. Unplug the device during lightning storms or when it will be unused for long periods.
14. All servicing should be performed by qualified personnel. If the device is damaged (e.g.,
power cord or plug is damaged, liquid has entered, it has been exposed to rain or moisture,
operated improperly, or dropped), have it repaired immediately.

A lightning bolt inside an equilateral triangle indicates the presence of uninsulated “dangerous
voltage” inside the device that may cause electric shock.
An exclamation mark inside an equilateral triangle indicates important operating and
maintenance instructions in the accompanying documentation.
Warning
To avoid electric shock, do not use the device with extension cords or incompatible outlets
unless the plug can be fully inserted.
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2.2 Audio Wiring Reference

Balanced Connections
Either end of a balanced interface can be used for balanced connections.
Note: For XLR connectors, the female connector is used for output, and the male connector is
used for input.

Unbalanced Connections
RCA and 1/4-inch TS connectors are unbalanced, lacking the negative (cold) line.
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2.3 Specifications

Example: AVCore 8.8ae (with AES67/Dante)
Processor ADI SHARC 21489(x2)
Sampling Rate / Bit Depth 48 kHz / 24 bit
Preamp Gain 0/3/6/9/12/15/18/21/24/27/30/33/36/39/42/45/48 dB
Phantom Power +48 V/10 mA max
Frequency Response (20~20 kHz) ±0.3 dB
Maximum Level +18 dBu
THD+N ≤0.001%@ 4dBu, A-weighted
Input Dynamic Range 113 dB
Output Dynamic Range 113 dB
Channel Isolation @ 1 kHz 108 dB
Input Impedance
(Balanced Connection)

5.4 kΩ

Output Impedance
(Balanced Connection)

600Ω

System Latency < 3 ms
Operating Power AC110~240 V 50 Hz \ 60 Hz
Dimensions (W x D x H) 482 x 260 x 45mm
Shipping Weight 4 kg

2.4 Mechanical Data

Required Space
1U (W x D x H: 18.91” x 9.5” x 1.72” / 48.02 cm x 24.13 cm x 4.37 cm), depth excludes connector
clearance.
Allow at least 3 inches of additional space at the rear panel for connections; the exact clearance
depends on the cables and connection methods used.

Power Requirements
110~240 V AC, 50 Hz/60 Hz, maximum power 50 W.

Ventilation
Recommended maximum operating temperature: 30 °C / 86 °F.
Ensure at least 5.08 cm (2 inches) of clearance on both sides, and never cover ventilation
openings with paper, cloth, or curtains.

Shipping Weight
8.8 lbs (4 kg)
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2.5 Front Panel

(1) OLED Display: Shows device IP, firmware information, analog input/output signals, and more.
(2) POWER Indicator: Displays the device power status.
(3) IN Indicator: Indicates video source selection.
(4) Right-Side Buttons 1~4: Used to switch video sources; four video sources can be routed to the
output via these buttons.

2.6 Rear Panel

(5) USB Hub: Docking station connection.
(6) Type-C: Connects to OPS host or computer, supporting audio and video signal transmission
and software-based video conferencing.
(7) HDMI OUTPUT: Connects to display or output device.
(8) HDMI INPUT: Connects to camera or other signal sources.
(9) AES67/Dante Network Interface: Connects to AES67/Dante audio networks.
(10) INPUT Analog Signal Ports: Connect microphones, terminals, or playback devices.
(11) OUTPUT Analog Signal Ports: Connect to mixers, amplifiers, or active speakers.
(12) RS-232 Interface: Connects to control terminals or central control systems.
(13) Factory Reset Switch: Press and hold for 5 seconds while powered on to restore factory
settings.
(14) ETHERNET Network Control Port: Allows client computers to debug and monitor the device.
(15) POWER Input: Connects to 110 V~240 V AC power; the device powers on automatically
when connected.

LEM Commercial - AVCore Series User Manual V2



8

3 Software

3.1 Software Installation

System Requirements
 Windows PC with a 1 GHz processor or higher
 Windows 7 or later
 1 GB of free storage space
 Resolution: 1920 x 1080
 Color depth: 24-bit or higher
 Memory: 4 GB or more
 Network interface (Ethernet)
 CAT5 cable or existing Ethernet network

The audio processor includes built-in control software and does not require a CD for installation.
You can access the audio processor by entering its IP address in a browser, locate the download
link, download the software locally, and complete the installation. The factory default IP address
is 169.254.10.227, with a subnet mask of 255.255.0.0. First, configure your PC with an IP address
in the same subnet to enable proper access. Once the device is powered on, enter
“http://169.254.10.227/”in your browser to access it.

Before installing the PC software, ensure that a recent version of Microsoft .Net Framework is
installed.
Note
If the software download fails, try using Internet Explorer or Google Chrome, or disable
download prompt pop-ups in your browser settings and try again.

3.2 Using the Software

After launching the software, the main interface is displayed.
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Click the “Device List” button at the top right corner of the main interface, and the software will
automatically search for all processors on the network. You can connect to a specific processor as
needed; once connected, the connection indicator will flash. Each processor supports up to 8
users connected and controlling simultaneously.

3.3 Custom Edit Processing Module

Click the Edit button, then right-click on an input or output channel processing module to open
the editing dialog. You can replace the current module, delete it, or copy it. After editing, click
Upload to Host.
Note: When CPU usage exceeds 100%, it turns red, indicating resource overload. In this case,
uploading to the host is not possible, and the module must be re-edited.
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(1) You can add multiple devices of the same or different models, with support for simultaneous online editing
of up to 8 devices.
(2) The processing module editing function allows you to replace or remove processing modules on input and
output channels. You can also monitor CPU and memory usage in real time. When resource utilization reaches
100%, it is displayed in red and a warning indicates that resources are exceeded, requiring you to reconfigure
the processing.
(3) Upload the configured program to the device, enabling online editing with immediate online deployment.
(4) Each input and output channel supports reconfiguration of its processing modules. If the same
configuration is required, you can copy it to all channels.
(5) Device List: All DSP devices on the network can be discovered within the same local area network, including
devices across different subnets and VLANs.
(6) Restore the scene to its default values, returning the processor to the saved preset configuration.
(7) Restore factory settings, returning the processor to its original default configuration.
(8) Save Preset: Store the current configuration in the selected preset.
(9) Load Preset: Load a previously saved configuration file into the corresponding preset on the processor.

3.4 Audio Module Parameters

Module parameters can be adjusted in two ways:
(1) Click directly on an input or output channel module to access its parameter interface.
(2) Right-click the module to open the module quick configuration interface.
The following descriptions of module parameters are based on the first method.
3.4.1 Input Source

Sensitivity:Microphone preamp gain is adjustable in 17 steps: 0, 3, 6, 9, 12, 15, 18, 21, 24, 27, 30,
33, 36, 39, 42, 45, 48 dB.
Phantom Power: Provides +48 V phantom power for external condenser microphones. Do not
enable for line-level inputs or devices that do not require power to avoid damage.
Sine Wave: Adjust frequency to generate a sine wave from 20 Hz to 20 kHz; both frequency and
output level (unit: dBFS) can be adjusted via the fader or text input.
White Noise: Equal energy across all frequency components with a flat spectrum. Frequency
adjustment is ineffective in this mode; output level can be adjusted.
Pink Noise: Power is concentrated in the low-to-mid frequencies with a spectral decline of
approximately 3 dB per octave. Frequency adjustment is ineffective in this mode; output level
can be adjusted.

Fader Right-Click Menu on Main Interface
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Group Settings: Quickly opens the group settings interface.
Minimum and Maximum Gain: Limits the channel gain range. After system calibration, setting a
maximum gain can prevent external operation from affecting system stability.

3.4.2 Expander
An expander operates oppositely to a compressor, increasing the dynamic range of a signal. The
key difference is that a compressor affects signals above the threshold, whereas an expander
affects signals below the threshold. Expanders reduce low-level signals further. With a 1:2
expansion ratio, an input signal 20 dB below the threshold produces an output 40 dB below the
threshold. At a 1:20 ratio, the expander behaves similarly to a noise gate; in fact, a noise gate can
be considered an expander with an extreme ratio.

Expander Control Parameters
Threshold: The level below which the expander is activated, typically set to the ambient noise.
Ratio: The proportion by which the signal is attenuated once it falls below the threshold. Higher
ratios make the behavior closer to a noise gate.
Attack Time: The time required for the expander to reach the set attenuation after the input
signal falls below the threshold. Shorter attack times result in faster response to transient signals.
Release Time: The time needed for gain to return to the input level after the signal rises above
the threshold.
Attack and release times only affect the speed of gain changes, as an example:
The speed at which gain recovers from -40 dB to 0 dB is controlled by the release time.
The speed at which gain attenuates from 0 dB to -40 dB is controlled by the attack time.
Attack and release times are independent of the threshold setting. When the signal fluctuates
near the threshold, the attack and release times affect gain attenuation or recovery respectively.
Once the signal exceeds the threshold, the expander stops operating. When the signal falls below
the threshold again, the expander reactivates, and the release time takes effect.

LEM Commercial - AVCore Series User Manual V2



12

3.4.3 Compressor and Limiter

Compressor
A compressor reduces the dynamic range of signals exceeding a set threshold, while signals
below the threshold remain unchanged.

Control Parameters
Threshold: The level above which the compressor begins to reduce gain. The higher the input
exceeds the threshold, the greater the attenuation.
Ratio: Determines the proportion of attenuation applied to the portion of the input signal above
the threshold. For example, with a 2:1 ratio, a 2 dB signal above the threshold results in only a 1
dB increase at the output. A 1:1 ratio indicates no compression. Adjustable range: 1~20.
Attack / Release Time: Controls the speed of gain reduction and recovery to preserve the natural
transients of the signal and avoid pumping effects.
Output Gain: Gain compensation fader used to increase overall volume after significant
attenuation by the compressor.
G.R. and Output Meters: G.R. shows the amount of compression, while Output shows the level
after compression. For example, with an input signal of -6 dB, threshold -30 dB, and ratio 2:1, the
compression amount is 12 dB; the G.R. meter shows -12dB, and the Output meter shows -18 dB.

Limiter
A limiter ensures the signal does not exceed a set threshold. Similar effects can be achieved by
adjusting the compressor ratio. The key is controlling signals below the threshold and how gain
reduction is triggered before overshoot occurs.
Limiters typically operate in two stages:
(1) The first stage applies mild limiting without affecting overshoot.
(2) The second stage aggressively attenuates overshoot to ensure the output does not exceed
the threshold.
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3.4.4 Auto Gain Control (AGC)
Auto Gain Control (AGC) is a special type of compressor characterized by a low threshold,
medium to slow attack time, long release time, and high ratio. Its purpose is to adjust signals
with unstable levels to a relatively consistent target level while preserving dynamic range. Most
AGCs include a mute-detection feature to prevent signal loss during silent periods.
AGC is commonly used for normalizing CD player levels for background or hold music and for
reducing level variations in paging microphones.

Control Parameters
Threshold: When the input signal is below the threshold, no adjustment is made; when the
signal exceeds the threshold, AGC activates regardless of whether it is above or below the target
level.
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Ratio: The ratio between input changes and output changes when the signal exceeds the
threshold.
Target Level: The desired output level. If the signal exceeds the target, AGC compresses it
according to the ratio; if the signal is below the target but above the threshold, AGC increases it
according to the ratio to approach the target level.
Attack Time: The time required for AGC to reach the set gain after the input signal exceeds the
threshold.
Release Time: The time required for the signal to return to its original level after the input signal
falls below the threshold and AGC stops acting.

3.4.5 Parametric Equalizer (PEQ)
Equalizers are primarily used to correct overemphasized or underrepresented frequency ranges,
regardless of bandwidth. They also allow adjustment of the frequency range width or
modification of specific bands’ energy, thereby shaping the signal’s tonal character.

Control Parameters
Type: Default is parametric EQ; high/low shelf or high/low pass filters can also be selected.
Different filter types achieve different processing effects.
High & Low Pass Filters:
High Pass: Passes signals above the cutoff frequency while attenuating signals below it.
Low Pass: Passes signals below the cutoff frequency while attenuating signals above it.
High & Low Shelf Filters:
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High Shelf: Boosts or cuts gain for signals above the set frequency.
Low Shelf: Boosts or cuts gain for signals below the set frequency.
The set frequency is the center point of the filter’s rise/fall, with Q affecting peak sharpness.
Frequency (Hz): The center frequency of the filter.
Gain (dB): The amount of gain boost or attenuation at the center frequency.
Q Factor: Filter quality factor, adjustable from 0.02 to 50.
In parametric mode, Q defines the width of the bell-shaped frequency response.
For shelf or high/low pass filters, Q > 0.707 produces peaking, Q < 0.707 results in a gentler slope
and earlier roll-off.
Each EQ band has a switch to enable or disable it, and the module master switch enables or
disables the entire EQ module. When editing, the parametric EQ can be configured with 5, 8, or
12 bands.

3.4.6 Graphic Equalizer (GEQ)
The graphic equalizer uses a constant-Q design, where each frequency band corresponds to a
dedicated fader. The filter bandwidth remains constant regardless of boost or cut. Professional
GEQs typically divide the 20 Hz~20 kHz range into 10, 15, 27, or 31 bands for adjustment. The
current system provides options for 10, 15, or 31 bands.

3.4.7 Feedback Suppression
When using the feedback suppression module, it should complement good system design and
engineering practices rather than follow poor design. Traditional methods such as limiting the
number of active microphones, reducing the distance between sound sources and microphones,
optimizing microphone and speaker placement and angles, and EQ’ing the room response,
should still be applied before enabling the module to achieve additional gain. Feedback
suppression cannot compensate for design flaws or increase gain beyond physical limits.

LEM Commercial - AVCore Series User Manual V2



16

Module Function
The feedback suppression module automatically detects and attenuates acoustic feedback in the
audio system. It distinguishes feedback from normal audio and automatically inserts notch filters
at detected feedback frequencies. Initially, filters apply light attenuation; if feedback persists,
they progressively increase attenuation according to the settings until feedback disappears or
reaches the maximum. Users can fine-tune parameters for precise control.
Each channel has a feedback suppression module. Click “On” to enable the module and
automatically detect feedback points and suppress them with narrowband filters. Each module
supports 8, 12, or 16 narrowband filters.

Adjustable Parameters
Panic Threshold: Signals exceeding this level are treated as feedback, triggering:
(1) Temporary output gain reduction to control feedback buildup;
(2) Limiting output level to prevent runaway;
(3) Increased filter sensitivity to speed up feedback detection.
Gain and sensitivity recover once the output drops below the threshold. Setting to 0 (unit:dBFS)
disables this function.
Feedback Threshold: Signals below this level are not treated as feedback, preventing false
detection from soft music or low-level noise.
Filter Depth: Maximum attenuation a single filter can apply. Shallow settings reduce signal
damage but may be less effective in seriously resonate systems.
Bandwidth: Options are 1/10 Oct or 1/5 Oct, constant-Q, independent of depth. For speech,
1/10 Oct is recommended; for frequent feedback scenarios, 1/5 Oct improves suppression but
may affect sound quality more.
Step Size: Attenuation amount applied each time feedback is detected.
Notch Mode: Automatic or manual.
Automatic: Filters cycle automatically; once 8 filters are used, when new feedback occurs, auto
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filters can automatically cycle to handle temporary feedback.
Manual: Filter gain and frequency can be set manually. Locks filters after ring detection to
prevent changes during performance, which can be used in fixed installation.
Another way is to copy those notch filters to dedicated EQ modules.
Clear: Instantly clears all filter parameters, typically used for retuning.
Tuning Recommendations
(1) Reduce system gain and use the Clear button to reset filter parameters.
(2) Set feedback suppression parameters and lower the panic threshold to reduce the feedback
trigger level.
(3) Turn on all microphones and gradually increase system gain until feedback occurs.
(4) Allow the feedback suppression module to act; once feedback disappears, continue
increasing gain.
(5) Repeat until the system reaches the desired gain or all filters are allocated.
(6) Adjust the panic threshold slightly above the maximum expected non-feedback signal level.
(7) Optionally, lock filters or save dynamic states to handle potential feedback during
performance, or copy filters to EQ notch modules to increase filter count.
If the system includes speakers, it is recommended to use compressor/limiter modules for
protection to ensure speakers are not damaged, even if all notch filters are exhausted or
feedback suppression cannot control feedback temporarily.

3.4.8 Noise Gate
The primary function of a noise gate is to block signals below a set threshold, typically used to
suppress unwanted noise.

Control Parameters
Threshold: Signals above the threshold pass through; signals below trigger the gate and are
attenuated or blocked.
Depth: The amount of attenuation applied to signals below the threshold. The minimum value
typically corresponds to complete closure of the gate.
Attack Time: The speed at which the gate opens when the signal exceeds the threshold.
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Release Time: The speed at which the gate closes when the signal falls below the threshold.
Hold Time: The duration the gate maintains the original output after the signal falls below the
threshold (e.g., 10 ms) before starting attenuation, preventing gate flutter caused by short signal
interruptions.

3.4.9 Ducker
A ducker automatically attenuates the volume of a target channel when the level of a reference
channel exceeds a set threshold, creating a ducking effect.

Control Parameters
Threshold: The reference signal level at which the target channel begins attenuation; below this
level, the target channel returns to its original level.
Depth: The amount of attenuation applied to the ducked channel.
Attack Time: The time required for the target channel to reach the set attenuation after the
reference signal exceeds the threshold.
Release Time: The time required for the target channel to return to its original level after the
reference signal falls below the threshold.
Hold Time: The duration the target channel maintains attenuation after the reference signal
drops below the threshold before recovery begins.

3.4.10 Ambient Noise Compensation
The Ambient Noise Compensation automatically adjusts the output level of a target channel
based on the level of a reference channel (sensing and processing ambient noise). Unlike a
ducker, which only attenuates signals, ANC dynamically adjusts volume according to changes in
the reference signal, either increasing or decreasing it. It is commonly used in background music
systems: when ambient noise rises, background music volume increases appropriately; when the
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environment is quiet, the volume decreases accordingly.

Control Parameters
Max Gain:Maximum volume increase after triggering.
Min Gain:Minimum volume after triggering attenuation.
Gain Sensitivity Ratio: The ratio of volume change relative to the reference signal.
Speed: The rate at which volume increases or decreases.
Trim: Digital gain adjustment after triggering.
Noise Threshold: The reference signal level at which the target channel begins gain adjustment;
below this level, gain decreases.
Distance: The distance between the reference signal and the pickup microphone and the nearby
speaker.

3.4.11 AutoMixer
In conference rooms, if multiple microphones are active at the same gain while only one person
is speaking, inactive microphones will pick up ambient noise and reflections. Mixing these signals
degrades audio quality and increases the risk of feedback. The AutoMixer automatically reduces
the gain or mutes unused microphones, providing faster and more effective control than manual
operation.

Gain-sharing AutoMixer
The processor includes a gain-sharing AutoMixer supporting up to 32 input channels. Each input
channel has a direct output influenced by automatic gain, channel fader, and channel mute.
Channels can disable AutoMixer participation; their gain remains unaffected by automatic mixing
and does not influence other channels.
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AutoMixer Module Control Parameters
(1) Main Control Parameters

On/OFF: Enable or disable the AutoMixer.
Gain: Controls the overall AutoMixer output level.
Slope: Determines the attenuation of low-level channels. Higher slope values attenuate quieter
channels more. Similar to an expander’s ratio; 2.0 is recommended for ideal gain sharing, 1.0
disables AutoMix, and 3.0 may produce unnatural results.
Response Time: Faster response preserves the initial syllables of speech; too slow results in
overly smooth transitions. 100~1000 ms is typically optimal. The AutoGain design ensures
channels open faster than they close, so even at 100 ms response time, speech onsets are
preserved.
(2) Channel Control Parameters
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AutoMixer On/Off: Enables or disables channel participation in AutoMix.
Mute: Channel mute and fader adjustments apply after AutoMixng. A loud channel can still
reduce other channels’ gain unless AutoMixer is disabled for that channel.
Gain: Adjusts the channel’s relative volume using fader.
Priority: Sets channel priority, 0~10 (default 5). Higher-priority channels override lower-priority
channels. A 1-point priority difference produces around 2 dB gain difference at a slope of 2.0.
Extreme slopes and priority differences may cause high-priority channels to dominate
low-priority ones, which can be mitigated using noise gates or expanders.

Gating AutoMixer (Automatic Threshold Sensing)

Developed based on noise gates; each channel has only on/off states.
Gain: Overall AutoMixer output gain.
Hold Time: Duration a channel remains open after speaking stops, recommended 300~800 ms.
Off Gain: Attenuation for inactive channels.
Sensitivity: Determines whether a channel activates during low SNR or quiet speech.
NOM Atten: Attenuation applied as more microphones are active; doubles with the number of
microphones. For example, setting 3 dB results in 2 active mics attenuated 3 dB, 4 mics
attenuated 6 dB.
NOM Limit:Maximum number of active microphones for AutoMix.
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Noise Threshold: Channels open when the signal exceeds this threshold, close when below.
Gating AutoMixer uses adaptive thresholds (ATS), automatically set after 6 seconds of silence
with microphones active.

3.4.12 Acoustic Echo Cancellation (AEC)
Acoustic Echo Cancellation (AEC) is a digital audio signal processing technology used to eliminate
acoustic echo caused by remote speech being played through local loudspeakers and re-captured
by microphones in a conference room, ensuring clear and natural communication. Without AEC,
the remote signal reproduced locally can be picked up again by microphones, creating echo that
degrades the meeting experience. The AEC algorithm removes the local echo and improves the
clarity of the remote speaker’s voice.

Operating Principle
The remote signal is sampled and used as the reference signal.
The echo generated by local sound reinforcement of the remote signal is estimated.
The estimated echo is subtracted from the microphone input so that the resulting signal no
longer contains remote echo.

DSP Controller AEC Module
The module provides two signal buses:
(1) Local input signal (microphone input)
(2) Remote input signal (reference signal)
Multiple signals can participate in echo cancellation through the mixer.

Non-Linear Processing (NLP):
When nonlinear distortion caused by local room reflections prevents the reference signal from
fully canceling residual echo, NLP is used for further suppression. Available levels are:
Conservative: Minimal suppression, preserves more of the original signal
Moderate: Balanced suppression and signal fidelity
Aggressive: Maximum echo suppression, may slightly affect signal naturalness

Note: The AEC module must be used together with the matrix module for proper signal routing
to ensure correct signal paths and effective echo cancellation.
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3.4.13 Noise Suppression
The Noise Suppression module effectively removes non-vocal sounds, distinguishing human
speech from other audio and treating non-speech as noise. Audio containing both speech and
noise is processed so that, ideally, only speech remains, improving voice clarity.

DSP Controller Configuration
Only one Noise Suppression processing bus exists in the system.
Using a multi-channel mixer, multiple signals can simultaneously undergo noise suppression
processing.

Parameter Settings
Suppression Level: Options are 6 dB, 10 dB, 15 dB, 18 dB.

The value indicates the amount of noise attenuation. Higher values increase noise suppression
but may also affect the speech signal and this trade-off is unavoidable.

3.4.14 Matrix
The Matrix module supports both routing and mixing functions. Horizontally, it represents input
channels; vertically, output channels. By default, each input corresponds one-to-one with an
output.
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For example, to mix signals from Input 1 and Input 2 into Output 1, simply check the boxes
corresponding to Inputs 1 and 2 on the Output 1 row. If an input channel participates in
AutoMixer, the output will be affected by the AutoMixer settings. Similarly, after configuring
modules like AutoMixer, Acoustic Echo Cancellation (AEC), or Noise Suppression, ensure proper
routing in the matrix to maintain correct signal paths.
The rightmost horizontal input in the matrix shows routed signals from the processed bus output,
not from individual input channels. Do not mix bus routing and independent input channel
routing simultaneously, as this may cause duplicated signals. Differences in delay and processing
between paths can result in phase cancellation or severe distortion.
During matrix routing, right-click the matrix node to open the independent fader interface, which
controls the send level from a specific input channel to a specific output channel. The default
send gain is 0 dB, with no attenuation or boost. Adjusting the fader allows fine control of the
same input signal across different output channels.

3.4.15 High Pass & Low Pass Filter
Each output channel is equipped with an independent high-pass and low-pass filter module.

Each filter includes the following parameters:
Frequency: The cutoff frequency of the filter. For Bessel and Butterworth filters, the cutoff is
defined at -3 dB; for Linkwitz-Riley, at -6 dB.
Gain: Adjusts the overall signal amplitude, providing boost or attenuation across the full
frequency range.
Type: Selectable filter types include Bessel, Butterworth, and Linkwitz-Riley. Butterworth filters
offer the flattest passband.
Slope: The attenuation rate of the filter’s transition band, selectable as 6, 12, 18, 24, 30, 36, 42,
or 48 dB/Oct. For example, 24 dB/Oct indicates that the signal decreases by 24 dB for each
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octave in the transition band.
Enable the high-pass or low-pass filter by clicking the ON button at the bottom.

3.4.16 Delay

ON/OFF: Activates the delay module, inserting it into the audio signal path to apply a fixed delay.
Milliseconds: Sets the delay time, ranging from 1 to 1200 ms. This value can also be converted to
distance in meters or feet.

3.4.17 Output

Phase(Inverse Polarity): Inverts the audio signal phase by 180°.
Mute:Mutes or unmutes the channel.

Right-Click Menu: Similar to input channels, right-clicking provides access to certain quick
settings for convenient adjustment.
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3.4.18 Level Meter
The digital level meter is used for real-time monitoring and analysis of each channel's audio
signal level, ensuring optimal device performance and audio quality. It allows you to visually
assess signal levels, determine whether system gain settings are appropriate, check for distortion
or clipping, and verify overall audio performance.

Measurement Unit: Digital level in dBFS (maximum 0 dBFS)
Reference Mark: Green scale indicates the standard voltage level (0 dBu)

3.4.19 USB Soundcard
The USB soundcard serves two main functions: PC-based remote conferencing and
recording/playback. When connected via the USB interface, the audio signal passes through the
Acoustic Echo Cancellation (AEC) and Noise Suppression modules, making it convenient for
integration with remote conferencing systems. Playback and recording functions can also be used
independently within the software interface.

Remote Conferencing Setup
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Soundcard Configuration
Connect the DSP device host to the OPS host using a dual-ended Type-C USB cable. On first
connection, the computer will automatically detect the new hardware and install the driver.
Once installed, a new device named “USB Soundcard” will appear in the computer’s soundcard
list and will automatically be set as the default audio device.

Playback and Recording Operations

(1) Sound track playback information: double-click to enter the playlist
(2) Next track
(3) Pause
(4) Playback volume adjustment
(5) Play
(6) Previous track
(7) Recording list
(8) Recording volume adjustment
(9) Stop recording
(10) Start recording
The software playlist allows management of song files and can be saved for future use. Click
“Open Folder” at the bottom of the playlist to select songs for playback, or clear the playlist.
Additional operations can be accessed through the soundcard settings interface.
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3.4.20 Camera Tracking (Intelligent Audio-Triggered Video Tracking)

The camera trace logic control supports two modes: ATS AutoMixer mode and Conference
System mode.
ATS AutoMixer Mode: Designed for systems with multiple independent microphones, each
connected to the DSP device via analog or Dante signals. Camera tracking is triggered based on
the ATS Threshold AutoMixer algorithm.
Conference System Mode: Designed for traditional daisy-chained or adjustable beam forming
microphone setups. Camera tracking is triggered via communication between the DSP host and
the microphone host, with the microphone host sending IDs or specific commands.

ATS AutoMixer Mode

Camera Tracking Parameters
(1) Channel tracking on/off status
(2) Input channel audio signal status
(3) Communication protocol (between DSP and Camera, supports RS-232, UDP, TCP, Visca IP)
(4) Camera network IP address (required for UDP or TCP; Visca IP can automatically detect LAN
camera IP)
(5) Camera communication port (select or fill in based on camera model)
(6) Control code type (supports HEX or ASCII string commands)
(7) Camera control code (preset recall code; manual entry required for RS-232/UDP/TCP, Visca IP
can auto-detect after camera login)
(8) Priority (high, medium, low)
(9) Video input sources (up to 4 HDMI inputs; can connect cameras, computers, etc.)
(10) Control signal output status (flashing indicates camera tracking is triggered)
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(11) View mode
Single-view: always outputs a single video source
PiP: supports 2-, 3-, or 4-window layouts; different combinations selectable and require
confirmation to take effect
Two-window tracking: one fixed source, one camera-tracked variable source

(12) Camera tracking reference timing coefficients:
Close-up peak detection: duration a microphone must be active to trigger close-up
Close-up stabilization: duration to maintain triggered close-up
High-priority view stabilization: duration to maintain higher-priority view
Multi-speaker peak detection: duration for triggering simultaneous speaking mode when
microphones of equal priority are active

(13) Priority multi-speaker stabilization, priority multi-speaker audio signal status
(14~16) Camera communication protocol, camera IP, port
(17~18) Camera preset control type and code
(19) Video input source
(20) Control signal output status
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(21) USB audio signal: for soft video conferencing, computer audio can be routed via DSP USB-C
soundcard; priority and trigger threshold can be set to control independent camera view for
remote speaker
(22) Remote signal: for hardware video conferencing, selected far-end channel signals can trigger
new local scene views; priority and trigger threshold can be set to control independent camera
view for remote speaker
(23) No local speech peak detection: when no local microphone signal is detected for a set
duration can trigger silence mode, which often corresponding to a panoramic view

Note: After completing the settings, ensure the module is switched on and click SAVE to apply
changes.

3.4.21 Camera
The Camera page allows control of cameras via the DSP software. The interface provides two
control methods on the left side: ONVIF-based and Serial/IP-based.
ONVIF-based:
Automatically searches for IP cameras on the local network using the ONVIF protocol. After login,
cameras can be controlled or their IP addresses modified, similar to accessing the camera’s web
interface. This is particularly convenient when setting up camera tracking, as preset positions can
be quickly adjusted. When Visca IP protocol is selected in the Trace logic control module, the IP
addresses and corresponding presets of logged-in cameras are automatically displayed for direct
selection.
Serial/IP-based:
Allows selection of the communication protocol and manual entry of the camera IP address for
control.
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(1) Camera Control:
UDP / TCP method: Requires the camera IP address and port number; specific settings depend
on the protocol and camera model.
RS-232 serial method: Ensure the DSP RS-232 baud rate matches the camera’s baud rate, with
wiring corresponding to the camera pan-tilt port.
PTZ and optical control: Up, down, left, right, focus, iris.
(2) Camera Preset Management:
Preset Number: Choose camera preset.
Save: Save current position to the chosen camera preset.
Clear: Clear the chosen camera preset information.
Recall: Load chosen camera preset.

3.5 Setting Menu

3.5.1 File Menu

(1) Open. In offline mode, clicking “Open” will display a file selection dialog, allowing you to load
an existing preset file (extension: .xxxdsp). Another way is to right-click a preset file and choose
to open it with the DSP.exe application.
(2) Save. The “Save As” function allows you to save the current preset from the application to
your local hard drive for backup or copying purposes.

3.5.2 Device Setting
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Used to configure device name, network address, dual-device hot backup, and serial port baud
rate. The device name can be up to 16 characters longs.
Default Startup: Two startup modes are available:
(1) Select any of the 16 presets as the startup preset; this preset will load every time the device
powers on.
(2) Choose Last Loaded Preset to load the preset that was active before the device was last
powered off.
Dual-Device Hot Backup:
Click Set as Master and enter the backup device IP address to complete the dual-device hot
backup configuration.

3.5.3 Group Setting
The group interface has Input and Output tabs, allowing channels to be grouped separately. Each
channel can belong to only one group. Channels within the same group will have synchronized
volume and mute settings. Other module parameters are not synchronized within a group, which
differs from the LINK function.
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You can select the number of channels in each group, with the maximum depending on the
device model purchased. In the main interface, each group is displayed in a distinct color.

Group vs. LINK:
When channels are assigned to a group, they do not participate in LINK. Grouping takes priority
over LINK; it only controls gain and mute for the channels, whereas LINK can synchronize all
parameters across channels.

3.5.4 Preset Name
Supports editing names for up to 16 preset slots, making it easier to quickly select and manage
different scenarios.
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3.5.5 Panel Setting
The panel setting supports two types of panels: Button Panel and OLED Panel. Through the panel
setting interface, multiple physical panels can be connected to the DSP device, and simple
configuration allows the panels to control the DSP device.

Device from the left is suitable for offline editing. Engineers can first configure panel parameters
locally and then download them to online panels. Alternatively, editing can be done directly on
online panels from the right: drag the panel into the design area in the online panel section and
double-click to edit.
Both the panel and the device have a small circle. Click the circle to draw a connection line and
select the target device to establish a link between the two devices. Double-click a panel in the
design area to enter its configuration interface.
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The configuration steps for each panel type are as follows. After configuration, click the
Download icon on the toolbar to download the settings to the hardware panel.
OLED Panel
The OLED panel features a 1.3-inch OLED screen and a rotary knob. The screen displays a
hierarchical menu, divided into three categories: Volume, Button, and Preset.
Operation Steps:
(1) The main interface shows the panel name and IP address. Rotate the knob left or right to
switch menus.
(2) Press the knob to make the second line of the menu blink and enter edit mode.
(3) Rotate the knob to adjust values.
(4) Press the knob again to exit edit mode and return to menu mode.
Menu Configuration:
Double-click the OLED panel to enter detailed settings. Click Add Menu to select menu items.
After configuration, click the Download icon on the toolbar to transfer the settings to the
hardware panel.
Button Panel
The button panel includes 8 buttons and a rotary knob. The knob adjusts gain, while the 8
buttons can be programmed for various functions, including Volume, Mute, Preset, and
Command.

LED Indicator Description:
(1) Solid On: Button configured for mute function.
(2) Blinking: Button configured for gain function, linked with the knob to adjust channel gain. The
LEDs around the knob indicate gain level: all off = -72 dB, all on = 12 dB.
(3) Momentary On: Button configured for preset or command function.

3.5.6 User Interface Overview
The user interface function allows engineers to create custom control interfaces, which can be
edited by system integrators and operated by on-site technicians or end users. Through targeted
design and editing, the interface can achieve an optimized and concise layout, providing an
intuitive and user-friendly experience, which is a key part of the product experience.
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3.5.7 Mobile Device Usage
Online Template Selection
After installing the mobile app, ensure the screen stays on and that the mobile device and PC are
on the same local network. For the download link of the mobile app, please consult the device
supplier.

Editing Interface
In the editing interface, drag controls from the left panel to use. Hovering over a control will
display its type. After placing the desired control, you can adjust its size and layout on the canvas.
To modify control properties, select the control and adjust settings in the right-hand properties
panel. When multiple identical controls are selected, properties are displayed uniformly; when
multiple different controls are selected, only shared properties are shown.
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Upload to Mobile Device (Data Synchronization)
After completing the layout, click “View > Sync” to upload the control interface to the mobile app.
If the upload times out or the device cannot be found, close the software, reopen it, and try
again.

3.5.8 Client Usage
For PC-based control, the design canvas should match the client’s resolution rather than using
mobile templates. You can add a custom client canvas size via “View > Template > Local Template.”
After completing the layout, use “File > Save As” or “Save” to generate a local file. This file can be
opened as a client Windows based control interface and can also be re-imported into the editor
for further modification and saving.

3.5.9 User Management
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Enable Account Login
Click the “+” icon to add sub-accounts. There is only one main account, which cannot be deleted,
but it can manage sub-accounts by adding or removing them.
When account login is enabled, accessing the device in the PC software requires entering the
corresponding username and password.

3.5.10 Video Setting
On this page, you can set the resolution of the device’s video output card to better match the
resolution of the display terminal.

3.5.11 Help
About: View software version, device model, and related information.
Help Documentation: Access the software user manual.
Control Commands: Retrieve commands; refer to Chapter 4 for details.
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4 Control

4.1 Control Command

After opening the Control Command window under Help, click any parameter on the software
interface that you wish to control. The window will instantly display the corresponding
command.
Step Control and Fixed Value Command
When adjusting a channel fader, the default command type is a fixed value. To implement step
control, select Step at the bottom-right corner of the Control Command window and choose the
desired step value. The command will then switch to a step-type command instead of a fixed
value.
Status Commands
Parameters such as Mute and Matrix have two states (pressed and released), each corresponding
to a different command. Pay attention to the command variation with the state when retrieving
commands.
Command Usage
After obtaining the desired command, copy it and send it to the DSP device via UDP or RS-232
using third-party control devices to achieve remote control.

4.2 External Control Programming

External control programming supports UDP and RS-232, covering all DSP processor control
parameters, including parameter control, parameter retrieval, and preset recall.
(1) UDP Control
The default port is 50000 and can be modified in the PC software under Device Setting.
(2) RS-232 Control
Default settings: baud rate 115200, data bits 8, stop bit 1, no parity. These can also be modified
in Device Setting.
Note: When sending RS-232 messages, maintain a minimum interval of 150 ms between
messages.
Control Response
If DSP needs to send replies to the control device, enable the Control Response switch in Device
Setting.
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4.3 ASCII Control Command

(1) Channel numbering starts from 0. Therefore, channels 0~3 correspond to IN1~IN4 in the
software interface. This is just an example; the actual number of channels depends on the device
model.
(2) For function ON/OFF settings, `1` means ON and `0` means OFF. For example:
```
set:output#mute#0-3#1
```
Here, the last `1` indicates that the mute function is enabled.

ASCII Control Command Examples (Detailed)
4.3.1 Input Gain Control & Query
```
set:input#gain#0-3#1 // Set gain of input channels 0~3 to 1 dB
get:input#gain#0-3 // Get gain of input channels 0~3
Return example: get:input#gain#0-3#1#1#1#1 // Channels 1~4 gain = 1/1/1/1
```
4.3.2 Output Gain Control & Query
```
set:output#gain#0-3#1
get:output#gain#0-3 -> get:output#gain#0-3#1#1#1#1
```
4.3.3 Phantom Power Control & Query
```
set:input#phant#0-3#1
get:input#phant#0-3 -> get:input#phant#0-3#1#1#1#1
```
4.3.4 Input Mute Control & Query
```
set:input#mute#0-3#1
get:input#mute#0-3 -> get:input#mute#0-3#1#1#1#1
```
4.3.5 Output Mute Control & Query
```
set:output#mute#0-3#1
get:output#mute#0-3 -> get:output#mute#0-3#1#1#1#1
```
4.3.6 Sensitivity Control & Query
```
set:input#sens#0-3#1 // Set input sensitivity to 3 dB (second step)
get:input#sens#0-3 -> get:input#sens#0-3#1#1#1#1
```
4.3.7 Matrix Control & Query
```
set:mixer#switch#0#0-3#1 // Route input 1 to outputs 1~4
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set:mixer#switch#0-3#0#1 // Route inputs 1~4 to output 1
set:mixer#gain#0-3#0#1 // Set gain 1 dB for inputs 1~4 to output 1
get:mixer#switch#0-3#0 -> get:mixer#switch#0-3#0#1#0#1#1
```
4.3.8 Scene Recall & Save
```
scene:toggle#3 // Recall scene 4
scene:save#3 // Save scene 4
```
4.3.9 Input Level Query
```
get:input#level#0-3 ->get:input#level#0-3#-105.4#-102.5#-105.2#-104.8 // unit: dBFS
```
4.3.10 Output Level Query
```
get:output#level#0-3
Return example: get:output#level#0-3#-56.0#-40.8#-43.6#-46.4
```
4.3.11 SystemMute Control & Query
```
set:sysctl#mute#1 // Enable system mute
get:sysctl#mute -> get:sysctl#mute#1
```
4.3.12 Set & Query Channel Names
```
set:input#name#0#1
get:input#name#0-3 -> get:input#name#0-3#IN1#IN2#IN3#IN4
```
4.3.13 Input/Output Phase Control & Query
```
set:input#phase#0-3#1
set:output#phase#0-3#1
get:input#phase#0-3 -> get:input#phase#0-3#1#1#1#1
get:output#phase#0-3 -> get:output#phase#0-3#1#1#1#1
```
4.3.14 Input/Output Step Control & Query
```
set:input#step#0-3#10
set:output#step#0-3#10
```
4.3.15 Input/Output LINK Control & Query
```
set:input#link#0-3#1
set:output#link#0-3#1
get:input#link#0-3 -> get:input#link#0-3#1#1#1#1
get:output#link#0-3 -> get:output#link#0-3#1#1#1#1
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```
4.3.16 Signal Type Control & Query
```
set:input#type#0-3#1
get:input#type#0-3 -> get:input#type#0-3#1#1#1#1
```
4.3.17 Restore Factory Settings
```
set:refactory
```
4.3.18 Reset Scene
```
set:rescene
```
4.3.19 Get/Set Any Scene Name
```
set:scene#name#0-3#pre1 // Set scene name (PC supports UTF-8)
get:scene#name#0-3 -> get:scene#name#0-3#pre1#pre1#pre1#pre1
```
4.3.20 Modules and Control Items

Module Control Items
input mute, gain, sens, phant, type, freq, name, phase, step, link, level
output mute, gain, name, step, link, level
mixer switch, gain
scene toggle, save, name
sysctl mute
rescene
refactory

4.3.21 Set Command Format
```
set:ModuleName#ItemName#StartChannel-EndChannel#Value
```
Examples:
```
set:input#mute#0-3#0 // Mute off for input channels 0~3
set:input#mute#0-3#1 // Mute on for input channels 0~3
```
4.3.22 Get Command Format
```
get:ModuleName#ItemName#StartChannel-EndChannel
```
Example:
```
get:input#mute#0-3 // Get mute status of input channels 0~3
```
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5 Frequently Asked Questions (FAQs)
Q: How to restore factory settings?
A:
(1) Connect the device to a PC via RS-232 using terminal software (recommended: SecureCRT).
(2) Serial parameters: 115200 baud rate, 8 data bits, no parity, 1 stop bit.
(3) After connecting, long-press Enter in the terminal to restart the device into the bootloader
interface.

Command explanations:
`del config` ~ Delete configuration information (e.g., IP address). Device IP resets to default

`169.254.20.227`.
`del scenes` ~ Delete all presets; all 16 presets revert to default values.
`del all` ~ Delete all partitions except the program.

> Note: Some SecureCRT installations may not show local echo. Enable it via Options >s Session
Options > Local echo.
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Thank you for reading this manual section.
We hope it helps you quickly understand and operate the device.
If you encounter any errors, unclear explanations, or technical issues, please contact us for
prompt clarification and correction.
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